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INTRODUCTION.

1. This 400 page tutorial has been optimized for use by the JAWS screen reader. So extra punctuation is
sometimes inserted in order to create pauses in speech output, especially in sentences containing
technical terms and concepts. Because of the extra punctuation, JAWS' punctuation level should be set
so that it doesn't say common punctuation marks like commas, periods, exclamation marks and question
marks. The punctuation level of "Some" will accomplish this.

2. Note that in previous versions of this tutorial, the middle section of the PC keyboard that lies between
the Qwerty section and the numpad, was referred to as the Mid Section. Now, however, it is referred to as
the Extended section. So now, for instance, the 2 different Left Arrow keys are referred to as Extended
Left Arrow, and Numpad Left Arrow. Similarly the 2 different Page Down keys are called Extended Page
Down, and Numpad Page Down.

3. There are 2 main sections to this document. The Table of Contents, and the CakeTalking Lessons. If
you have MS Word, then all items in the Table of Contents are links. So if you find a subject in the Table
of Contents that you wish to move to, ARROW to somewhere inside the line of text, and press ENTER,
and you will be moved to that subject. On the other hand, if you do not have MS Word, then the items in
Table of Contents are not links. In that case, if you fine a subject you wish to move to, select it, copy it,
and then paste it into the Find dialog. Then press ENTER and you will move to that subject. You can also
quickly scan through this tutorial by pressing CONTROL+DOWN ARROW, or CONTROL+UP ARROW.
This will move you from paragraph to paragraph. If you cannot find in this tutorial the solution to a
particular problem that you are having in SONAR, then try the following.

a. When in SONAR, press INSERT+H. This will open the hotkey help dialog that contains a list of
categories of hotkeys. Press ENTER on a category, and a list of hotkeys for that category will open up.

b. The document named Hotkey Help for CT 8, found in CakeTalking's Tutorials folder. This document
also contains a list of all of the CakeTalking hotkeys. The hotkey is usually listed first, followed by the
function it executes.

c. The document called What's New In CT8 found in CakeTalking’s Tutorials folder. If there is a hotkey
that you were used to in CakeTalking 7, but cannot find in CakeTalking 8, this document describes the
differences in the hotkeys, and what hotkeys no longer function in CakeTalking 8.

d. There are 2 documents in CakeTalking’s Tutorials folder dedicated to providing help on the real-time
effects, and soft synths that have been made accessible by CakeTalking. They are named, "Supported
Real Time effects", and "Supported Soft Synths."

e. SONAR'’S own Help Program. When you are in SONAR, just press F1, 2 times quickly. SONAR’S Help
program provides additional information not yet documented in this tutorial.

f. INSERT+F1. This is the default JAWS hotkey for Screen Sensitive help. In SONAR, it works well in
conventional windows, like dialogs. But in the main SONAR views, it may not provide useful information.

g. Instructions for setting up your MIDI Audio workstation and configuring SONAR so it recognizes your
external synths and modules are given in Lessons 56 through 62 as well as in the excellent document,
"How To Setup Your Workstation", found in CakeTalking's Setup folder.



h. If the above resources still don't answer your questions, you can contact your dealer or e-mail Dancing
Dots. The Dancing Dots e-mail address is support@dancingdots.com

4. Periodic updates to CakeTalking are posted on your Dancing Dots website. In the future, to check if
you have the latest version of CakeTalking, make sure you are connected to the Internet, and then do the
following.

a. From the Start Menu, open Programs, and then open the CakeTalking 8.5 sub menu.

b. At the bottom of the sub menu, you will find CTWebUpdate. Press ENTER on it and the CakeTalking
Web Update dialog will open.

c. Press Space on the button named, Check for Updates Now. You will be natified if there is a new
version available for update. If so, you can download the latest version, by navigating to the button
named, Download Update Now.

5. CakeTalking is compatible with Hot Spot Clicker, a set of scripts that allows you to create hotkeys for
inaccessible windows. Note that if you have been using hot Spot Clicker, and have HSC sets, then after
every new installation of CakeTalking, you will need to refresh the JAWS Keymap so that includes the
HSC hotkeys. To do this, just do the following.

a. With JAWS loaded, open SONAR and press ALT CONTROL SHIFT + F10.

b. Arrow to Refresh Keymap and press ENTER. That's it. For detailed instructions on installing and using
Hot Spot Clicker, go to http://www.hotspotclicker.org/

6. For further tech support contact your dealer or E-mail Dancing Dots at support@dancingdots.com If
you want to join the DDots-l list, so that you can share questions and answers with others, send a blank
E-mail message with the word “subscribe” in the subject line. Send it to ddots-I-request@freelists.org
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LESSON 1. LOADING A NEW, EXISTING OR RECENT PROJECT.

1A. Three Ways to Start a Project in SONAR.

1. When you first open SONAR 8.5, you'll hear JAWS tell you the CakeTalking 8 scripts are loaded, and
that you should wait until the screen has settled down before doing anything. So relax and don't be too
impatient. You'll come to learn from what JAWS says, when SONAR has completely loaded.

2. After SONAR is completely loaded, what is the first thing you'd like to do? Well, it could be one of three
things.

a. You'd like to start a completely new project. If so, you can start working in the template that
automatically loads when Sonar first opens. Or you can pick a different template to work in from
SONAR'’S New Project dialog.

b. You'd like to open an existing project. It could be one of your own projects, or someone else's. In that
case, the projects are available from SONAR’S Open dialog.

c. You'd like to open one of your most recently opened projects. Well, 8 of the most recently opened
projects are listed at the bottom of SONAR'’S File menu. Press ENTER on any of them, and that project
will load.

3. If you want to start a completely new project, and don't want to work in the default template that opens
when SONAR starts up, then use the New Project dialog. You can open the New Project dialog, by
opening SONAR’S File menu, with ALT + F. Then arrow to New, and press ENTER. You actually don't
even have to arrow to New, just press the letter N, and the New Project dialog opens. So, to make it fast,
just press ALT + F, then release the ALT key, and press N. The New Project dialog will open.

4. The new Project dialog contains many different templates, and each different template contains a
different configuration of tracks. Of course, none of the tracks have been recorded on, so you're starting
out with a blank slate. If you are going to use a template, use one that starts with AAA. These templates
have been configured to CakeTalking specifications. Some of the AAA templates found in the New
Project dialog contain nothing but MIDI tracks. Others contain only audio tracks. And still other AAA
templates contain a mixture of audio and MIDI tracks. Not only that, but some templates contain only 4
tracks, others 8 tracks, and still others 16 or more tracks. Some AAA templates have MIDI tracks
assigned to software synthesizers that create their sounds from within the computer. These templates are
probably the easiest templates to use when you wish to get up and going quickly. Still other templates
have MIDI tracks configured to trigger external synthesizers. So when starting a new project from the New
Project dialog, you're bound to find the AAA template that best suits your purposes. We'll describe the
New Project dialog in greater detail later in this lesson. But now let's look at the second option that you
have. Opening an existing project that's already been recorded in.

5. To open an existing project, you can press CONTROL + O and SONAR'’S Open dialog pops up. The
Open dialog is similar to many other Open dialogs in standard Windows programs. There's a file name
edit field, where you can type a name for the project, and there's a list view above that, where you can
find projects that you can select to load. In the list view, there are also folders that contain projects. If you
press ENTER on a folder, it opens up and displays the projects inside it. So, once you've selected a
project from the list view, you can press ENTER, and the project loads. More information on the Open
dialog will be given later in this lesson. But first, let's take a look at the third and final option. Opening a
recent project.



6. Conveniently, 8 of the most recently opened projects are listed at the bottom of the SONAR'S File
menu. They're listed with numbers in front of them. For instance, say that the very last project you worked
on was named, "My First Romance." Then in the File menu, you'd find the following listed. "1. My First
Romance." But let's also say that the day before, you worked on a project named, "The Second Time
Around.” Well then, in the File menu, you'd also find, "2. The Second Time Around." This numerical listing
of your recently opened projects continues for the 8 most recently opened projects, in chronological order.
So it's easy to open one of those projects. Just open the File menu, with ALT + F. Then, since those
projects are at the bottom of the File menu, UP ARROW to get to them quickly, and then press ENTER to
load one of them. Of course, you can also just press the number of the project. You don't even have to
ARROW through them. For instance, to open the most recently opened project, which in our example
was, My First Romance, just press ALT + F, then 1. Bingo! My First Romance will load.

7. So to review, you have 3 options. Open a new project from the New Project dialog by pressing ALT +
F, then N. Open an Existing project from the Open dialog by pressing CONTROL + O. And finally, open
one of the 8 most recently opened projects from the file menu, by pressing ALT + F, then choosing one of
those projects from the bottom of the File menu.

1B. Options For What SONAR Displays When Opening SONAR.

1. Some folks like to have all 3 of the above options available as 3 buttons, in a single dialog. So, SONAR
also provides a Quick Start dialog that has a button for opening the Open dialog, a button for opening the
New Project dialog, and a button for loading one of the 8 most recently opened projects. The Quick Start
dialog can be made to pop up whenever you open SONAR. Then you can TAB to one of those 3 buttons
and press it in order to start working on a New Project, an existing project, or one of the most recently
opened projects. Note that when you first install the SONAR program, the Quick Start dialog is made to
open at the start-up of SONAR. But at the bottom of the Quick Start dialog, there's a checkbox named,
"Show this at Startup." By default, that checkbox is checked. However, if you uncheck it, then the Quick
Start dialog will not open at Startup. So, if you find that when you open SONAR, the Quick Start dialog
does not open, then that means at some time in your history of using this version of SONAR, or a
previous version of SONAR, you unchecked the option to open the Quick Start dialog at Startup. But if it
has been disabled from popping open at Startup, and you decide that you want it to open at Startup, you
can easily re-enable it to open at Startup. You see, you can open the Quick Start dialog at any time,
because it's also available from SONAR’S Help menu. So, to re-enable the Quick Start dialog to open at
Startup, here's what you'd do.

a. Open SONAR’S Help menu with ALT + H.

b. ARROW to Quick Start and press ENTER. The Quick Start dialog pops up.
c. TAB to the checkbox named, "Show this at Startup.”

d. If it's unchecked, press SPACE to check it.

e. TAB to the OK button and press ENTER. The Quick Start dialog will close, but whenever you open
SONAR in the future, it will always pop open at Startup.

2. As stated earlier, you can open any of the last 8 recently opened projects from the File menu. Here's
how to open one of those recently opened projects from the Quick Start dialog.

a. Tab to the Open a Recent project combo box.
b. Arrow through the list of recently opened projects to the one that you want.

c. SHIFT TAB back to the Open a Recent Project button and press SPACE. The project will then load,
and you'll be ready to go to work.



3. When you first installed CakeTalking, there was a page in the CakeTalking installer that tells you to
pick from one of 3 different templates that will load when SONAR starts up. This template will load when
SONAR starts up, whether or not the Quick Start dialog also opens. The template you pick, will be
initialized as the Normal Template, which is the template that will load when SONAR opens. On the other
hand, if you don't want the Normal template to load at Start up, you can uncheck a certain checkbox in
the Global Options dialog. That checkbox is named, "On Startup, Load the Normal Template." Here's how
to find that checkbox, and check it, or uncheck it.

a. Open SONAR’S Option menu with ALT + O.
b. ARROW to Global, and press ENTER, or just press the letter G. The Global Options dialog pops up.

c. The Global Options dialog contains 7 pages. We want to select the Audio Data page. So press
CONTROL + TAB until you hear JAWS say Audio Data.

d. In the Audio Data page, TAB to the checkbox named, "On Startup, Load the Normal Template."

e. If it's checked, pressing SPACE will check it. If it's not checked, pressing SPACE will uncheck it. So by
checking or unchecking it, you can make the Normal Template load on Startup, or not load on Startup.

f. Finally, press ENTER to close the Global Options dialog. That's it.

4. So now that you are familiar with the options for what SONAR will display at Startup, let's summarize
the possibilities.

a. The Normal template will open, and the Quick Start won't. You can immediately start working in your
Normal template.

b. Both the Normal Template and the Quick Start dialog will open. In this case, you can either ESCAPE
from the Quick Start dialog, and immediately start working in your Normal template. Or, you can choose
one of the 3 buttons in the Quick Start dialog.

c. The Quick Start dialog will open, and the Normal Template won't. You can then choose one of the 3
buttons in the Quick Start dialog.

d. Neither the Normal Template nor the Quick Start dialog will open. In that case, in order to start working,
you must either open the Open dialog to load an existing project, the new Project dialog to load a
template, or the file menu to choose a recently opened project.

1C. The New Project Dialog.

1. A template is a project with nothing recorded in it. There are many different templates. Each template is
distinguished by its number of tracks and buses. For instance, there is a template called Normal. This
template, will be the template that you picked when you Installed CakeTalking, and the one that loads
automatically when SONAR starts up. There are also templates that have a different number of MIDI and
audio tracks, and templates with no audio tracks but many MIDI tracks, and templates with no MIDI tracks
but many Audio tracks. There are templates devoted to software synthesizers, and even a blank template
that has no tracks and buses, where you will have to add them by yourself. When loading a template from
the New Project dialog, It is recommended that you load only the Normal template, or those templates
that start with the letters AAA. These are CakeTalking templates that are designed to have the screen
configured for optimum performance for CakeTalking and the JAWS screen reader.

2. The New Project dialog contains a list of all your templates. You can open the New Project dialog
directly from the File menu, or from the Quick Start dialog. To open it from the File menu, press ALT + F,
then N. To open it from the Quick Start dialog, tab to the Open a New Project button, and press it with
SPACE. In either case, the New Project dialog opens, containing a long list of templates from which you
can choose.



3. The New Project dialog actually has 2 different configurations. One configuration has the template list,
plus several more options in it. And the other configuration merely has the list of templates, plus the OK
and Cancel buttons. This simpler configuration is exactly the configuration used in previous versions of
SONAR. Which configuration will be the one you will see? Well, it all depends if a checkbox named, "Use
Per Project Audio folders" is checked or not. If it's not checked, then you'll get the simple New Project
dialog. But if it's checked, the New Project dialog will contain more options. But what is this "Use Per
Project Audio folders" checkbox? And why do we have to learn about it now?

4. Well, first of all it's important to understand that in previous versions of SONAR, by default, all of the
audio files that you recorded were put in one folder. This folder contained all the audio data that you
recorded in all your projects. Now this is still an option in SONAR 8. You can in fact store all of your
project's audio data in one folder. But that's not what happens by default. Instead, each projects audio
data is actually put in its own folder. For instance, if you have recorded an audio project named "Big
Deal," then there will also be a folder solely dedicated to storing the audio in the Big Deal project. Do you
see how that might be convenient when trying to manage, import or export just the audio files of a
particular project? You no longer have to search through the myriad audio files of one Global Audio
folder. You can just search through each project's audio folder. SONAR calls these audio folders, "Per-
Project Audio Folders."

5. Now, in the Global Options dialog, that's accessed from the Options menu, there's an Audio Data page.
And at the bottom of that Audio page, is a check box named, "Use Per-Project Audio Folders." Well, by
default that check box is checked. So whenever you create and name a new audio project, the audio that
you record in that project will be placed in that project's own audio folder. If, however, you uncheck the
Use Per-Project Audio Folders check box, then all the audio that you record in all your projects, will not be
put in individual folders. Instead, it will be put in one folder, called the Audio Data folder.

6. If the Use Per-Project folders checkbox is checked, which is by the default the case when you install
SONAR 8, then when you create an audio project, a folder with that name will be created. And inside that
folder will be the project file, and an audio folder. So if your project is named, "Big Deal", then there will be
a Big Deal folder, inside of which you'll find Big Deal .cwp, and an audio folder that contains all of Big
Deal's audio data. In either case, whether you're using Per-Project Audio Folders or not, both the per-
project folders, and the Global Audio Data folder will by default be found in the following folder path.
C:/Cakewalk Projects. So inside the Cakewalk Projects folder, you will find your audio project folders,
named after your audio projects, as well as the Audio Data folder that will store all project audio files
when you are not storing them in their own folder.

7. Now, what do these arcane details have to do with the New Project dialog? Well, if you have
deliberately gone into the Audio Data page of the Global Options dialog, and unchecked the Per-Project
Audio Folders checkbox, so that all audio data goes into the Audio Data folder, then the New Project
dialog will simply display a list of templates, plus the OK and Cancel buttons. This is in fact what the New
Project dialog of past SONAR versions looks like. In that case, loading a New Project is a cakewalk,
(forgive the pun). Simply open the New Project dialog, navigate in the list of templates to the one that you
want to use, and then press ENTER. Your template loads and SONAR'S ready to let you get down to
business.

8. On the other hand, if the Per-Project Audio Folders checkbox is not unchecked, then the New Project
dialog contains 4 additional fields. Here's what they are.

a. The Name edit field. This is the first field you will find when you open the New Project dialog. You will
be required to type a name for your project. That's no big deal. You can always rename it later. So just
enter a provisional name if you're not sure yet exactly what you want to name it.

b. TAB once and you will be in the "Location" edit field. This is where a folder that contains both your
project file, and its audio folder will be stored. By default, the location edit field will contain the path
C:\Cakewalk Projects. You can type another path there if you wish. But unless you're an advanced
user, that is not recommended. So you usually don't mess with the Location path.



c. TAB once from the Location edit field, and you will be in the "Audio Path" edit field. This will now
contain the full path to the folder that will be created. For instance, if in the Name field you typed "Big
Deal," then in the Audio Path field, you will find the following, C:\Cakewalk Projects\Big
Deal\Audio. What does that mean? Well, obviously, a folder named Big Deal will be created inside the
Cakewalk Projects folder. And inside that Big Deal folder, there will be a folder named Audio. That's the
folder where all audio you record in your Big Deal project will be stored. Also, the project file itself,

Big Deal .cwp, will be inthe Big Deal folder. So both Big Deal .cwp, and its audio folder will be in
the Big Deal folder.

d. TAB once from the Audio Path edit field, and you will be on a checkbox named, "Store Project audio in
its own folder." By default this will be checked. What is this checkbox for? Well, it's just confirming that
you want to use Per-Project Audio folders. However, if you uncheck it, then guess what? The top three
edit fields become grayed out and unavailable. In that case, your project won't have to be named before
loading a template, because no project folder and its accompanying audio folder have to be created.
You'll just name the project later, when you do your first save. In other words, by unchecking the "Store
Project Audio in its Own Folder" checkbox, your project will revert to the old way SONAR handled an
audio project. Namely, the audio files of that particular project will be put in the Audio Data folder, not in
its own folder. So, now you have the best of both worlds. By default, you will have per project audio
folders. But when loading a template from the New Project dialog, you can choose not to have per project
folders any time you don't want to.

e. TAB once from the Store Project Audio In Its Own Folder check box, and you will be in the Template
list. Choose a template, and press ENTER. That's it. You're ready to get down to it.

9. In the New Project dialog, you will find template named Normal. This is also a CakeTalking template.
It's the template that you chose when you installed CakeTalking. It can be also opened whenever you
want, by pressing CONTROL + N. You can also create your own Normal template by saving your project
as a Template, and saving it in the folder where templates are saved. Details on this will be provided
later.

10. Note that if you are not using per-project folders, then after loading a template and working in it, then
your first save with CONTROL + S, will actually open the Save As dialog. You will then have to give a
name for your project. So the project will not save as a template, but rather as a conventional SONAR file,
with the extension .CWP. This way, your templates don't accidentally get overwritten.

1D. The Open Dialog.

1. If you are not in the Quick Start dialog, you can open an existing project by pressing CONTROL + O. If
you are in the Quick Start dialog, then just press the Open a Project button. In either case, the Open
dialog will pop up, and you will find yourself in the File Name edit field. You can type the name of the
project that you want to load. Then press ENTER, and that file will load.

2. In the Open dialog, you can also select a project from the dialog's list view. The list view contains the
contents of a particular folder. This folder is defined in the Look-In box. We'll take a closer look at the
Look-In box later. Now, to move to and select a project from the Open dialog's list view, do the following.

a. From the Open Dialog's File Name edit field, SHIFT TAB to move to the list view. You will find folders
and files there. Use your ARROW keys to navigate in the list, or press the first letter of the folder or
project that you are looking for.

b. If you find the project, press ENTER on it, and that project will load.

c. If the project that you want to load is not visible in the list view, then if you know the folder that it is in,
then select it, and then press ENTER on it. The list view will then display the files in the folder. Then
select the project and press ENTER on it.

d. There is a folder called, "Sample Content.” It contains both MIDI and audio projects that SONAR users
have created. These projects are a great resource for testing out SONAR’S capabilities.



3. The list view of the Open dialog actually displays the contents of the folder that is listed in the Look In
Combo box. When you first load SONAR, and then open the Open dialog, the folder that is in the Look In
combo box will be the default folder where you store your projects. This default folder is defined in the
Folders page of the Global Options dialog. By default, the folder for your projects will be the

Cakewalk Projects folder. You can change the folder where by default your projects will be stored, by
reassigning it in the Folders page of the Global options dialog. Information on how to do that is in the
lesson on Changing SONAR'’S default folder paths.

4. If you can not find the project that you wish to load in the list view, then you can move to the Look In
combo box, and select another folder. Here's how to select another folder or drive from the Look In
combo box.

a. From the list view, SHIFT tab once or twice to the Look In box. You can also just jump to the Look-In
combo box by pressing its hotkey, Alt + 1.

b. Open the Look-In combo box with a Down Arrow. It may take a second or 2 to open.

c. Arrow up and down the Look In list, searching for the senior folder or drive whose contents you wish to
display in the list view.

d. When you find the folder or drive, press Enter to close the Look in List, and then tab once or twice to
move back to the list view. The list view will now contain sub folders and files contained in the senior
folder or drive that you selected.

e. In the List View, if you need to look in yet another sub folder, press ENTER on it. Continuing like this,
you will eventually display the file that you are looking for. You can then press Enter on it in order to load
it.

5. There is a way you can move to senior folders without having to move out of the list view. While in the
list view, pressing the BACKSPACE key will progressively move you up the folder hierarchy. Each time
you press backspace, the list view will display the contents of the senior folder. So, for instance, if you are
in the list view while Sample Contents is displayed in the Look-In Box, if you press the BACKSPACE key,
the look in Box will then change to display SONAR 8, which is the senior folder of Sample Contents.
Then, the list view will display all the folders and projects that are in the SONAR 8 folder.

6. If you use the Open dialog, and load a project from a folder that is not the default folder for saving your
projects, then if you open the Open dialog again, it will display that other folders contents, not the default
folder. But after closing SONAR, and then opening it again, then the Open dialog will again revert to
displaying the contents of the default projects folder.

7. Note that you can have multiple projects loaded at the same time. This way you can copy and paste
between projects. But if you would rather only allow one project open at a time, then you must go into the
Global Options dialog, and check the option nhamed, "Allow Only One Open Project at a Time."

8. Finally, it's vital to remember that after loading a new project, you always press F6. This configures the
screen to the best possible layout.

1E. The Save and Save As Dialogs.

1. Press Control + S, to save your project. If you are not using per-project folders and have never named
your project before, the Save As dialog pops open where you can type the name for your project.
Otherwise the Save dialog opens.

2. As with the Open dialog, both the Save and Save As dialogs have a list view and a Look In combo box.
So, if you wish, you can SHIFT TAB to them and select a different folder to save to.

3. You can also rename your project at any time by opening the Save As dialog by pressing ALT + F, then
A.

4. When you save a project, you do not have to type in its file extension. By default, the file extension will
be .CWP. See the lesson on Saving Projects for more details on saving.



1F. The AAA Templates.

1. It is suggested that you only use the Normal template, or the AAA templates for your project. Or you
can create and save a template that is based on the latter templates. These templates are configured
according to CakeTalking specifications. You are sure to find a AAA template that matches your projects
needs. Note that some of these templates may contain new SONAR plug ins. However, these new plug
ins may not be available unless you make SONAR scan for plug ins. You see, whenever you install a new
version of SONAR, or install a new plug in, in order for SONAR to recognize the new plug ins, SONAR
needs Scan all your VST folders for the new plug ins in order to make them available in SONAR. To do
this, do the following.

a. Open the Global Options menu, with ALT +O.

b. CONTROL TAB to the VST Plug ins page.

c. In the VST Plug ins Page, TAB to the Scan VST folder button, and press ENTER. Or just press ALT S,
and the scanning will start automatically.

d. Wait until the scanning is complete. This may take a minute or two.

e. When scanning is complete, SONAR will be out of focus. So ALT TAB until you hear you're back in
SONAR.

f. Close the Global Options dialog. That's it. your new plug ins will be available.

We'll now provide a detailed description of each one of the AAA templates. Note that some of the details
may be obscure to you until you've studied the relevant section of this tutorial.

AAA MIDI Softsynth TTS-1 16 Track. When installing CakeTalking, this is one of the 3 choices for what
will be the Normal template that loads at SONAR startup. This template contains 16 MIDI tracks, and 4
TTS 1 audio tracks, each one of which is assigned to a different TTS 1 Virtual Output. By default, the 16
MIDI tracks only use the first virtual output. However, by configuring the TTS 1 Options dialog, one can
assign any of the MIDI tracks to use any of the other virtual outputs. This template also includes 4 mono
audio tracks.

AAA MIDI External Synth 16 Track. This has 16 MIDI Tracks, and one Master bus. The 16 MIDI tracks
are configured to output MIDI to the synth that's assigned to MIDI Port 1 in the MIDI devices dialog. If Port
1 is not sending to an external synth, then either manually configure the MIDI Devices dialog so that the
desired external synth is Port 1, or on each MIDI track's Output column, change it to a port that does send
to the desired external MIDI synth.

AAA Audio8. Contains 8 mono audio tracks, and 3 buses. A master bus and 2 effects buses. Each audio
track has 2 sends.

AAA Audiol6. Contains 16 mono audio tracks, and 3 buses. A master bus and 2 effects buses. Each
audio track has 2 sends.

AAA Audio24. Contains 16 mono audio tracks, and 5 buses. A master bus and 4 effects buses. Each
audio track has 4 sends.

AAA Audio Karaoke. Contains 8 mono audio tracks, and 3 buses. A master bus and 2 effects buses.
Each track has one send. The template contains the following plug in effects. Boost 11, Sonitus
Compressor, and Sonitus Reverb.

AAA Audio Voiceover. Has 2 audio tracks, and 3 buses. Master bus and 2 effect buses. One track is for
the voice over, and the other for a backing track. The voice over track goes through the Sonitus
Compressor, and the backing track goes through the Sonitus gate and compressor.

AAA MIDI Softsynth Chill Loops and Arps. For SONAR Producer edition only. It has 6 Soft synth simple
instrument tracks assigned to specific patches, and one mono audio track. It has 2 buses, a Master bus
going through the Sonitus Compressor, and an effects bus going through the Pantheon Reverb. The soft
synth tracks use 3 different instances of Dimension Pro, and 3 different instances of Rapture L E, and
each track is pre assigned to a specific patch.



AAA MIDI Softsynth Jazz Trio. For SONAR Producer edition only.Has 4 tracks. 1 mono audio track, and 3
soft synth simple instrument tracks dedicated to the Session Drummer, Dimension Pro, and TruePianos
and each track is pre assigned to a specific patch. Each track has one send. The template has 2 buses, a
Master bus going through the Sonitus compressor and an effect bus going through Lexicon pantheon
reverb.

AAA MIDI Softsynth Piano Pop. For SONAR Producer edition only.Has 5 soft synth simple instrument
tracks and a mono audio track going through the Sonitus Gate and Compressor. A Master bus going
through the Sonitus compressor and an effect bus going through Lexicon pantheon reverb. The soft synth
tracks are dedicated to 2 instances of Rapture L E, 2 instances of Dimension pro, and TruePianos, and
each track is pre assigned to a specific patch.

AAA MIDI Softsynth Rock Band. For SONAR Producer edition only.Contains 7 soft synth simple
instrument tracks, and 1 mono audio track. A master bus going through the Sonitus Compressor, and an
effects bus. The soft synth tracks are dedicated to 6 different instances of Dimension Pro, and one
instance of Session Drummer. Each track is pre assigned to a specific patch. The Session drummer track
goes through the Vintage Channel V 64 compressor.

AAA MIDI Softsynth Rock Trio. For SONAR Producer edition only.Has one mono audio track going
through the Sonitus Gate and Sonitus compressor, and 3 soft synth simple instrument tracks assigned to
2 instances of Dimension Pro, and 1 instance of TruePianos. The soft synth tracks are assigned to
drums, bass and piano. It has a master bus, and an effect bus going through the Lexicon Pantheon.

AAA MIDI Softsynth Smooth Jazz. For SONAR Producer edition only.This has 8 soft synth simple
instrument tracks assigned to several different instances of Dimension Pro, 1 instance of TTS 1, and 1
instance of Rapture L E. The soft synth tracks are assigned to drums, bass, electric piano, nylon guitar,
muted guitar, synth pad, synth lead, and sax. The template has a master bus going through the Sonitus
Compressor, and an effects bus going through the Lexicon Pantheon.

AAA 0 Blank Project. This is a template with no tracks in the track pane, or buses in the bus pane. To
learn how to insert tracks and buses yourself, see the lesson on Inserting Tracks and buses.
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